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PowerTeacher Gradebook: Analysis and Reporting 

The Scoresheet 

Use the Scoresheet to create and score assignments, and view or 
edit final grades. The Scoresheet is divided into three modes: 
Assignments, Final Grades, and Student View. Regardless of the 
mode you choose, the left section of the pane displays the status of 
the term, the names of the students in the selected class, and the 
students’ current final grades. 

Assignments Mode 

1. On the Scoresheet, click the Assignments mode 

2. To the left of the assignment headings, click the + sign to 
add a new assignment 

3. In the lower pane, enter the assignment details and click 
Save 

4. To delete an assignment, select the assignment you want to 
remove, and to the left of the assignment headings click the 
- sign 

5. Click Yes 

6. To score an assignment, click a student’s score cell and 
enter a score manually, fill scores, or use the Score 
Inspector 
 
When you change a score for an assignment, the new score 
immediately affects the Final Grade for that student. 

7. To view mean, median, and mode values for each of the 
assignments, click Summary 

• The mean is the mathematical average of the scores 

• The median represents the middle of all values: one-half 
of the scores will be above this number and one-half will 
be below 

• The mode indicates the most common, or frequent, 
value 
 
Use these values as indicators of how well students 
perform on assignments. If any of the values are 
unexpectedly low, it may mean that students need 
additional practice on the skills and concepts you’re 
assessing, or you need to revise the assignment. 

Final Grades Mode 

1. On the Scoresheet, click the Final Grades mode 

2. Enter final grades for additional academic measures such as 
Citizenship or Standards 

3. View all of the category totals for each student and change 
the format of the totals 
 
For example, to view letter grades for each category, right-
click on the Category heading and select Letter Grade from 
the menu. 

4. Below the student names, click Summary to view a 
summary of statistical information about the final grades 
your students have earned in each category or standard 

Student Mode 

1. On the Scoresheet, click the Student View mode 

2. View specific information for each student individually 

3. Above the student names, click Asmts to see all the 
assignment grades for the selected student 
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4. Click Terms to see all the term final grades for the selected 
student 

5. Click Cmnts to show the standards-based Comment 
columns for the selected student 

6. Click each of the Student View options a second time to 
hide the information 

Scoresheet Filters 

By default the Scoresheet displays all of the assignments you have 
created, listed chronologically by their due dates from right to left. 
Filter the Scoresheet to focus on one student’s assignments, 
assignments within a reporting period or time frame, or 
assignments within a category. 

To filter assignments by a reporting term or smaller unit of time: 

1. Above the student names, open the Reporting Term menu 

2. Select a reporting term, such as Q1, or select a smaller unit 
of time, such as Last Week 

 

To filter assignments by category: 

1. Using the filter menu in the Categories pane, choose Filter 
Selected 

2. Select a single category, such as Quiz, to show only the 
assignments in that category 

Select more than one category by holding down the Control 
key on a PC, or the Command key on a Mac, and selecting 
each category. 

3. View individual student scores in these categories 

4. Click Summary to view the summary of statistics for the 
selected categories 

Student Groups 

Group students together to increase your ability to adapt 
instruction to the students’ needs. You are not limited to grouping 
based on academics alone; the example below shows a grouping 
based on parents’ preferred contact methods. 

1. From the Classes pane, select a class 

2. In the Student Groups pane, click the + sign and choose 
Add Group Set 

3. Enter a name for the Group Set, such as Contact, and click 
OK  

4. Right-click on a PC, or Control-click on a Mac, Group 1 and 
select Edit 

5. Enter a name, such as Email, and click OK 

6. Click the + sign again and select Add Group 

7. Enter a name for your group, such as Phone, and click OK 
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Add Students to Groups 

1. Click the Assignments mode and expand your new group 

2. Select a student’s name and drag it to a group 

3. To add a group of students at one time, Control-click on a 
PC, or Command-click on a Mac, the student names and 
drag them into a group 

4. To change a student from one group to another, click the 
arrow to the left of the group name, drag the student’s 
name out of one group, and drop it into a different one 

Filter by Student Groups 

To filter the Scoresheet to show one student group only: 

1. Select a class 

2. In the Student Group pane, choose Filter Selected 

3. Select a group 

 

To filter the Scoresheet to show one student only: 

1. In the Student Group pane, choose Filter Selected 

2. Open the Active group 

3. Select a student 

Mass Fill Scores for Selected Groups 

Assign scores to a group at one time using your student groups 
and Fill Scores. Also, use the category filter to narrow the list of 
assignments down to a specific category. 

1. Select a class 

2. In the Student Group pane, choose Filter Selected 

3. Select a group 

4. In the Categories pane, select the category of the 
assignment you want to score, such as Homework 

5. Right-click or Command-click the assignment column, and 
select Fill Scores 

6. Using the Fill Assignment Scores window, mark the 
assignment Collected, Late, Exempt, or Missing for the 
whole group or enter a group score and a comment 

7. Click OK to fill scores for the group 

8. Click Save 

Reports  

Use the reports available in the gradebook to provide a paper or 
electronic copy of information to show the principal, a student, or a 
parent. Personalize each report by entering a custom title or 
including a top note, bottom note, and signature line. Several 
types of reports are available, and you can present them in three 
output types: PDF, HTML, or Text Export (CSV). 

• Attendance Grid - Use to mark attendance manually when 
outside the classroom. Format to print for specific dates or 
no dates. 

• Category Total Report - View a summary of category 
totals for a student or class. Report a specific term or all 
terms. 

• Final Grade and Comment Verification - View final grade 
information for your students. Select to include all final 
grade information or specific information, like final letter 
grades. 

• Individual Student Report - View a summary of class 
information per student, similar to a progress report. 
Choose the date range and what grade information to print. 

• Missing Assignment Report - View a list of students with 
missing or not yet scored assignments. Select to print the 
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student number instead of the name so you can post the list 
publicly. 

• Scoresheet - Print a paper copy of grade and assignment 
data. Choose to print all categories or one category, and 
select to include final grades and assignments. 

• Standards Report - View a student’s standards final 
grades and standards assignments scores for a specific 
reporting term. Organize the report by class or by student. 

• Student Multi-Section Report - View final grade 
information for all of a student’s sections, not just your 
class. Specify the grades to include and show dropped 
classes. 

• Student Roster - View student demographic information. 
Select to include a variety of student information and even 
format a column to keep track of money collected or 
permission received. 

Run the Individual Student Report 

Use the Individual Student Report when you want to print progress 
reports for one or all of your students. The report prints one page 
per student. 

To run the report for all students: 

1. Click the Reports tab 

2. Double-click Individual Student Report 

3. On the Criteria tab, select the report Output Type, such as 
PDF 

4. Select Active Classes to include students in all of your 
sections 

5. For Order By, choose Section, Student to sort the report 
by section and then alphabetically by students’ last names 

6. For Students, choose All Enrolled to print the report for all 
currently enrolled students 

7. For the Student Field criteria, select Student Name to 
specify how you want to list the student on the report 

8. For Abbreviate, check which items to abbreviate 

9. Use the Include options to specify the information you want 
to include on the report: Final Grades, Assignments, 
Comments, and Categories 

10. Choose a date range 
 
To enter a date range manually, select Manual and enter 
dates in the Start Date and End Date menus. 

11. Click the Layout tab 

12. Enter a title, such as Q1 Progress Report, in the Report 
Title field 

13. To ensure that only one student’s information appears per 
page, check On Sections and On Students for the Page 
Breaks options 

14. To include a note at the top, check include for Top Note 

15. In the text field, enter the note and check bold if you want 
the text to be in bold font 

16. To include a note at the bottom of the report, check 
include for Bottom Note 

17. In the text field, enter the note and check bold if you want 
the text to be in bold font 

18. Check include for Signature Line to insert a place to sign 
the report 

19. Click Run Report 

20. To view the report, select Open Report and OK 
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View Options 

Use zoom controls to change how you view the information on the 
gradebook window. 

To increase the size of the text on the Scoresheet: 

1. From the View menu, select Zoom 

2. Select Increase or a percentage, such as 200%, or press 
Ctrl + Shift + = on your keyboard 

 

To decrease the size of the text on the Scoresheet: 

1. From the View menu, select Zoom 

2. Select Decrease or a percentage, such as 80%, or press 
Ctrl + Shift + - on your keyboard 

Moving Panes 

Move panes when you want to hide certain PowerTeacher 
Gradebook window panes, or when you want to expand the visible 
area of a pane. 

• Use the arrows at the top of a pane to expand or collapse 
the pane; for example, if you want to see more of the 
Scoresheet, close the Tabs pane 

• To resize the height of panes, click the gray horizontal 
separation bar in the pane and drag it up or down to change 
its position 

• To resize the width of a pane, click the pane’s vertical 
separation line and drag the line to the left or right to 
change its position 

New Window 

When you want to view or work with more than one class at a 
time, open a new gradebook window. 

1. To open a new window, open the Window menu and select 
New Window 

2. To view a different class, in the Classes pane, select the 
class 

3. Move the new window to do a side-by-side comparison of 
students’ scores 

4. Enter new scores or navigate to a different gradebook page 

5. Close the window as you would close any other web page 
 
When you close the new window, the original window 
remains open; your session is not terminated. 
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Scoresheet Quick Entry Keys 

On the Scoresheet, enter score indicators manually, fill score 
indicators, or use the Score Inspector to enter indicators. In 
addition to those score entry methods, use the Quick Entry Keys to 
mark assignments as Collected, Late, Exempt, or Missing. 

To mark an assignment as Collected: 

• Enter col in a student’s score cell and press Enter 

• Enter a period (.) in the score cell and press Enter 

• Right-click in the score cell and select Collected from the 
menu 

 

To mark an assignment Late: 

• Enter lt in a student’s score cell and press Enter 

• Enter an asterisk (*) in the score cell and press Enter 

• Right-click in the score cell and select Late from the menu 

 

To mark an assignment Exempt: 

• Enter ex in a student’s score cell and press Enter 

• Right-click in the score cell and select Exempt from the 
menu 

 

To mark an assignment Missing: 

• Enter mi in a student’s score cell and press Enter 

• Enter a forward slash (/) in the score cell and press Enter 

• Right-click in the score cell and select Missing from the 
menu 

 

Gradebook Preferences 

Use the Preferences window to indicate how you want grades to be 
calculated, stored, and displayed. Also, choose how to distinguish 
your different sections, format your Spell Check, create personal 
comments and score codes, and set up standard-based 
calculations. 

1. Open the Tools menu for a PC, or the PowerTeacher 
Gradebook menu for a Mac, and select Preferences 

2. Use the Comment Bank tab to create personal comments 

3. On the Grading tab, format the grading options that meet 
your preferences or your school’s policies 

• Rounded option - a grade of 89.75% would be rounded 
to 90% 

• Truncated option - the same grade would be calculated 
as 89% 

• Choose to store grades with up to 5 decimal places 

• Choose to display final grades with letter grade, percent, 
or points earned 
 
If you clear all of the check boxes, the Final Grade 
column will be blank. 

• Choose to display absences and tardies 

• Choose to display assignment grades with letter grade 
and percent 

4. Use the Mail tab to enter an email signature 

5. Use the Score Codes tab to enter codes specific to your 
gradebook 

6. Use the Section tab to identify your sections by period day 
or section number, list your classes by the course name or a 
custom name, and sort your courses by Period/Day, Section 
Number, or Course Name 
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7. Use the Spell Check tab to enable Spell Check and manage 
your dictionary 

8. Use the Standards tab to display standards in Final Grades 
mode, enable standard-based grading with assignments, 
and format auto-calculations 

9. Use the Student tab to format how students appear on your 
scoresheet 

10. When you are finished, click OK 

Add Content Groups and Web Links 

The Content modes contain links to websites and information on 
the web. Your PowerTeacher administrator provides the 
information you find in School Content. You can add online 
resources you’d like to use in My Content. If you plan to gather 
several links, consider creating groups of links as well as content 
groups. Then select a group for the link you are adding.  

To create a content group in My Content mode: 

1. Click the Class Content tab, and then click My Content 

2. Click Content Groups 

3. On the Content Groups window, click the + sign 

4. Enter a name for the group 

5. Select a color for the group 

6. Enter a description of the type of content included in the 
group 

7. Click Close 

 

To add a link to an Internet site: 

1. Click the + sign 

2. Enter the name and address of the website 

3. Choose a type for the content (“Web Site” is the default 
content type) 
 
To link to a document that resides on your district server, 
select PDF or Word Doc to match. 

4. If applicable, select a content group 

5. Enter a description 

6. Click Save 
 

The links and link groups will appear on the My Content page. 
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Import and Export Scores 

PowerTeacher Gradebook provides the tools for exporting 
Scoresheet information for a single assignment from the gradebook 
into a comma-separated values (csv) text file using the 
PowerTeacher Score Template. Then you can use the file to record 
assignment scores offline. Once you finish recording assignment 
scores, import the updated information back into PowerTeacher 
Gradebook.  

To export scores: 

1. Select a class and click Scoresheet 

2. Right-click or control-click the assignment heading of the 
assignment that you’re going to export and select Export 
Scores Template 

3. If you’ve already recorded some scores, click Yes to include 
them in the export  

4. On the Save Scores File prompt, verify that the Save As 
field populates with the name of the assignment followed by 
_pst.csv (add .csv if necessary) 
 
Although it is recommended that you leave the default 
setting, you may enter a different file name for the Scores 
template.  

5. Choose the location where you want to save the Scores 
template 
 
Desktop is the default location. 

6. Click Save 

7. Open the template using a spreadsheet application 

8. Enter scores for each student in the Points, Percentage, or 
Letter Grade column and save the file 

To import scores: 

1. Right-click the assignment heading you want to import 
scores for, and select Import Scores 

2. Select the import file and click Open 

3. On the Import Scores window, select the Advanced tab 

4. Select the format of the file 
 
If you exported a Scores template, rather than creating 
your own CSV or Text file, select PowerTeacher Score 
Template. 

5. Use the default values for the other import fields 

6. Select to keep the existing scores in the gradebook or 
overwrite the existing scores 

7. Review the scores that will be imported, and click Import 
 
The scores will now transfer correctly into the assignment 
and student score cells.  

8. Click Save 

 


